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Abstract 
 

The Prioritization Analysis Tool for All-Hazards/Analyzer for Wide Area Restoration 
Effectiveness (PATH/AWARE) software system, developed by Sandia National 
Laboratories, is a comprehensive decision support tool designed to analyze situational 
awareness, as well as response and recovery actions, following a  wide-area release of 
chemical, biological or radiological materials.  The system provides capability to 
prioritize critical infrastructure assets and services for restoration.  It also provides a 
capability to assess resource needs (e.g., number of sampling teams, laboratory 
capacity, decontamination units, etc.), timelines for consequence management 
activities, and costs.  PATH/AWARE is a very comprehensive tool set with a 
considerable amount of database information managed through a Microsoft SQL 
(Structured Query Language) database engine, a Geographical Information System 
(GIS) engine that provides comprehensive mapping capabilities, as well as 
comprehensive decision logic to carry out the functional aspects of the tool set.  This 
document covers the basic installation and operation of the PATH/AWARE tool in 
order to give the user enough information to start using the tool.  A companion user‟s 
manual is under development with greater specificity of the PATH/AWARE 
functionality. 
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1. AN OVERVIEW OF THE PATH/AWARE DECISION  
SUPPORT SYSTEM 

 
1.1. Overview 
 
PATH/AWARE is a decision support tool developed by Sandia National Laboratories (SNL) to 
aid in strategic planning for wide-area, urban chemical, biological or radiological (CBR) 
recovery operations. PATH/AWARE stands for the Prioritization Analysis Tool for All-
Hazards/Analyzer for Wide Area Effectiveness.  Recovery is defined in this context as the post-
response phase following a wide-area CBR incident that involves screening and characterization 
of potentially CBR contaminated areas, indoor and outdoor decontamination by one or more 
methods, and final outdoor or indoor facility clearance activities typically carried out via another 
round of post-decontamination sampling and analysis. The PATH/AWARE  tool is an 
integration of two software functions, namely, AWARE and PATH.  The AWARE tool can be 
thought of as a specialized version of typical project planning tools, such as Microsoft Project, 
that is custom built for CBR recovery operations. The tool allows the user to input one or more 
CBR contamination scenarios as well as estimates of resources available to do recovery. 
Additional strategic recovery decisions are made by the user after which the tool calculates 
recovery timelines and associated costs. The PATH tool allows for the rapid identification of 
critical infrastructure likely to be impacted from a CBR event. Additional functionality within 
the tool allows users to identify restoration objectives, and based on those objectives, the tool 
produces a prioritized list of impacted critical infrastructure for recovery operations. This 
prioritized list can then be passed to AWARE for the calculation of recovery timelines and costs 
for the critical infrastructure list.   
 
1.2. Tool Databases 
 
The PATH/AWARE  tool utilizes a Microsoft SQL (Structured Query Language) Server 
database to manage a large amount of data in order to provide the comprehensive analysis 
capability within the code.  PATH/AWARE  has an underlying database of region-specific 
facilities and critical infrastructure. Depending on the desired degree of fidelity for impacted 
facilities and areas, the user has two options. The first, lower-fidelity option involves the use of 
the HAZUS model database. HAZUS is an earthquake, hurricane and flood damage prediction 
and assessment tool developed and maintained by FEMA 
(http://www.fema.gov/plan/prevent/hazus/index.shtm). The HAZUS building database has 
building fidelity at the census block level with estimates of building types and square footage 
based on population data and other information. The HAZUS building database is implemented 
into the PATH/AWARE  tool and includes coverage for the entire United States. If the user 
desires additional facility data fidelity, another option exists within the tool for importing county-
specific tax information into the database. This importation feature requires software engineer 
support and, provided the tax databases are accessible, can by typically accomplished in less than 
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a week for a typical US urban area. Presently, the tool is populated with building databases for 
the Seattle-Tacoma region (King and Pierce counties) as well as for a five-county region in the 
greater Denver area. Limited data inclusions also exist for the National Capital Region. These 
county-specific tax assessor databases typically provide building-by-building descriptions for an 
entire county. Data items in a typical facility data record include building name, location, type of 
construction, building age, number of floors/stories, use category (e.g., residential, commercial), 
appraised value, as well as other parameters useful for recovery planning. US counties vary on 
the degree of information contained in these databases and typically the databases from each US 
county are slightly different in organization and structure.    
 
An additional data layer within the tool is the Homeland Security Infrastructure Protection 
(HSIP) database. HSIP is a DHS-sponsored and developed database of critical infrastructure 
assets for the entire US. These data are vetted and updated on a yearly basis by DHS.  The PATH 
tool provides geo-located descriptions of critical infrastructure in many different categories. In 
the present configuration of the tool, the HSIP-Gold database is implemented along with the 
HSIP-Freedom version. The Gold version of the database is deemed sensitive and is marked for 
official use only by federal entities; consequently when analyses are conducted using the Gold 
version, precautions are required in how results from the PATH/AWARE  tool are disseminated 
to process stakeholders.  The Freedom version does not have the restrictions that the Gold 
version does, but it has significantly less infrastructure. 
 
Other publicly available commercial databases, such as national listings of hospitals and fire 
stations, have also been assembled and could be integrated into the tool; however, these 
databases are only available for custom use situations and require the assistance of a software 
engineer for inclusion in analyses.     
   
1.3. The GIS Module 
 
The PATH/AWARE  tool has a built-in Geographical Information System (GIS) engine that 
enables the user to view much of the scenario and impact details in map format. The user can 
exercise a number of options in order to describe a scenario. The scenario is typically a ground-
level C, B or R contamination plot that is derived from other sources. In most instances, an 
atmospheric dispersion model coupled with downwind aerosol deposition calculations is used to 
generate an estimate of downwind ground-level contamination by an outside entity.  
PATH/AWARE  does not produce these model results, other codes can. These contamination 
maps can be imported into the PATH/AWARE  tool in a shapefile format, common to most GIS 
platforms. The user also has the option of hand-drawing a ground level contamination plume or 
area of interest using the GIS-interface. Plumes, either hand-drawn or imported, can be 
designated as red, yellow or green zones, based on their relative degree of contamination. The 
tool uses two map formats for display. One is a self-contained map of the US with moderate 
detail and resolution. The other is Google maps, which provides a much more detailed map layer 
with traditional road maps and satellite-derived maps available. The Google maps selection 
requires a moderate to high-speed internet connection, whereas the self-contained map version 
does not.  
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Once the contamination maps have been imported into PATH/AWARE , the GIS portion of the 
software can be used to view the potentially impacted critical infrastructure as well as all non-
critical buildings and outdoor areas that are found within the plume. Additional details 
concerning impacted CI can also be viewed. For example, color coding is used to display CI 
elements on the map and their degree of potential impact based on a number of criteria including 
whether they are located inside the plume and the extent to which other redundant and functional 
CI elements are available to offset the impacted CI asset. Typical GIS features enable to user to 
turn on or off the visual display of the many CI layers that exist within the tool. Typical CI layers 
that can be displayed include, police, fire, hospitals, airports, power stations, communication 
hubs, waste treatment plants and many more. Similar GIS features allow the user to display 
potentially impacted non-critical facilities by name, building size, and use category.  
 
The GIS engine embedded in PATH/AWARE  is from ThinkGeo (http://thinkgeo.com/).  There 
are no GIS licensing fees for the users of PATH/AWARE  because ThinkGeo has an upfront 
development fee but not a use fee.  Other GIS packages, such as the popular ArcGIS from ESRI, 
require each instance of a code utilizing their package to be licensed.  The licensing fees can get 
costly under that paradigm, but not under the one selected by SNL for implementation of 
PATH/AWARE .  
 
 
1.4. PATH Analyses 
 
Following a CBR event, there will be a need to address critical infrastructure in a timely manner.  
Typically, the Unified Command would be assembled and discuss the priorities for bringing 
critical infrastructure back up and running.  Each facet of the community is likely to claim 
importance over the others, such as police, fire, and emergency medical care.  A system was 
needed to evaluate these priorities in a more systematic fashion than just gathering around a 
conference room and arguing over the relative importance of each critical infrastructure or asset 
under consideration.   
 
The notion of prioritizing critical infrastructure on the basis of various metrics or objectives 
lends itself to a Multi-Attribute Utility Analysis method.  A form of a Multi-Attribute Utility 
Analysis was developed for the PATH module.  A key factor in this methodology is the user 
supplied weighting factors that are established for a set of objectives (e.g., maintain public 
safety) and functions (e.g., emergency services).  The functions can be weighted at the service 
level as well (e.g., law enforcement, firefighting, etc.)   The method also accounts for 
dependencies amongst the assets (e.g., a blood bank supplies blood to hospitals so it may have to 
be considered in order to have full functionality for the hospital).  The product of this 
prioritization method is a rank-ordered list of the critical assets that need to be restored.  This list 
is shared with the AWARE tool in order to calculate timelines and costs for the cleanup effort.  
The user may also manually change the rank order if other drivers become important to the 
decision makers that are not captured in the prioritization methodology. 
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1.5. AWARE Analyses 
 
AWARE analyses are initiated with the designation of a scenario. As noted previously, this can 
be done by importing a shape file from a source term/plume dispersion/deposition model or a 
scenario can be drawn by the user using drawing tools included within the software. Once the 
deposition plumes are designated, typically including a red, yellow and green zones, the tool 
interrogates the building database and summarizes the potential overall impact of the 
contaminated zones. A summary listing includes the area impacted, number of buildings, types 
of buildings (e.g. commercial, residential, public, etc.) and interior square footage in each of the 
designated zones.  Next, the overall plume areas are divided by the user up into smaller 
remediation units such as would occur in an actual recovery operation. Following that the user 
inputs a variety of remediation resources including such items as: the number of sampling teams, 
sampling rates, per sample costs, decon technologies to be used, threshold contamination levels 
for multiple decon technology choices, decon rates, costs, and many others. A number of 
strategic decisions can be made by the user that will influence overall timelines and costs. These 
decisions include the type of sampling used to infer whether a facility is ready for re-occupancy, 
the extent to which field-based sampling and analysis will be used, the extent to which decon 
will be applied to indoor and outdoor areas, and many others. 
 
Following designation of a scenario and the associated recovery resources, the software 
automatically calculates timelines and costs for the user-designated conditions and strategies. In 
calculating timelines, the AWARE software steps through the resource allocations, parameters 
and decision rules on a daily basis, until the entire timeline is complete.  This process provides 
specificity at a fairly low level and likely results in good predictive fidelity.  Graphical output 
displays include timeline charts, cost breakdown by recovery phase and a useful choke point 
graphic that indicates what particular recovery phases are slowing the overall recovery timelines. 
The tool is configured much like a spreadsheet, where the user can change resource or strategy 
input values and that change is followed by an immediate recalculation of the timeline and other 
output data of interest. This mode allows the user to manually carry out a variety of “what-if” 
calculations thereby facilitating trade-off analyses as the overall recovery process is explored.   
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2. INSTALLING PATH/AWARE SOFTWARE 
This section of the manual will guide you through installation of the PATH/AWARE software.  
You install the PATH/AWARE system from several DVD disks.  First, you install 
PATH/AWARE on a desktop or laptop computer.   
 
2.1 System Requirements 
PATH/AWARE runs on most off-the-shelf computers.  The Windows 7 operating system is 
recommended, and the code should run on either a 32-bit or 64-bit version. Administrator-level 
access is required for installation (due to the need for the Microsoft SQL Server database), but 
not necessarily for operation.   
 
2.1.1 Hardware 

PATH/AWARE operates on a desktop or laptop PC. The recommended minimum system 
configuration is: 
 

 A reasonably large hard disk is recommended as the code and data can take upwards of 
50 Giga-bytes (Gb) of storage. 

 2 GHz processor or faster 
 1 GB RAM or more 
 Monitor/video card supporting at least 1024x768 resolution and 16-bit color 

 
2.1.2 Windows User Privileges 

You must have Administrator user privileges to install PATH/AWARE on a computer.  
Administrator privileges allow the PATH/AWARE installation routines to properly configure 
your computer to work with PATH/AWARE. 
 
If you do not have Administrator privileges on your computer, do not proceed with 
PATH/AWARE installation.  Consult your system administrator about configuring your machine 
properly.  Alternatively, you may consult your computer owner‟s manuals or your Windows 
system documentation about how to configure your computer. 
 
2.2 Installing PATH/AWARE  
To install PATH/AWARE on a desktop or laptop computer you will have to manually copy files 
from several DVD disks and execute some installation packages. 
 
The first step in the process is to load a free version of the Microsoft .NET Framework 3.5 on the 
target computer.  The free download can be found at the following URL: 
http://www.microsoft.com/en-us/download/details.aspx?id=21 
 
The second step in the process is to load Microsoft SQL Server 2008 onto the target computer.  
A free version is available if you do not need all of the HAZUS database files accessible at one 

http://www.microsoft.com/en-us/download/details.aspx?id=21
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time, in which case the professional version should be purchased.  The free download can be 
accessed from the following URL: 
http://www.microsoft.com/en-us/download/details.aspx?id=23650 
When installing the SQL Server software, take note of the SQL Server name that is used to 
identify the instance of the server on the user‟s computer, you will likely need it when launching 
the PATH/AWARE software for the first time.   
 
It is also necessary to load the Microsoft SQL Server Management Studio software on the target 
computer in order to manage the database files.  This is also a free product and can be 
downloaded from the following URL: 
http://www.microsoft.com/en-us/download/details.aspx?id=7593 
As mentioned above, the user may need administrator privileges to install these two packages or 
require assistance from an Information Technology (IT) support person in their organization. 
 
Once the Microsoft SQL Server products are loaded, then the databases for the tool can be either 
attached or restored, depending on the file type on the installation disks.  The easier process is to 
restore a backup file of the databases.  That process is outlined here. 
 
From the Start menu, launch Microsoft SQL Server Management Studio.  The first pop-up screen 
should look something like the following: 
 

 
 

Figure 2-1.  SQL Server pop-up screen 

 
The Server name line might be blank the first time you access this application, so you may need 
to type in the Server name as noted during the installation of SQL Server.  Next, click on 
Connect.  The next screen should look something like the following: 

http://www.microsoft.com/en-us/download/details.aspx?id=23650
http://www.microsoft.com/en-us/download/details.aspx?id=7593
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Figure 2-2.  SQL Server Management Studio screen 

 
 
Next, insert a DVD disk containing the backup databases.  In the left pane, right click on the 
Databases folder and select Restore Database…  The next screen should look something like 
this: 
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Figure 2-3.  SQL Server Restore Database screen 

 
There will be several databases to restore within PATH/AWARE to make it function.  These 
databases are: PATH-AWARE Assets (the Critical Infrastructure data); Emporis (the building 
database); PATH-AWARE Scenarios (project-based analysis data); and HAZUS databases for 
each of the 50 individual states (limiting the restore to only 1 to 3 HAZUS databases at a time in 
SQL due to space limitations).   
 
Each database will have to be restored with the following process. In the dialog box shown 
above, the name of one of the databases should be typed into the To database: field.  Next, click 
the radio button to select From device:. Now click on the small box on the right of the same line 
with the three dots in it to call up a dialog box to select the database backup file.  The following 
window will now be displayed: 
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Figure 2-4.  SQL Server Specify Backup screen 

 
Click the Add button. Now a dialog window will appear from which the appropriate backup file 
may be selected (must be a file with the extension .bak).  Then click the OK button.  In the 
Restore Database window (as seen below), check the rectangular box next to the database name 
in the lower right pane of the window, then click the OK button to add this database to SQL.  
Repeat this operation for the rest of the databases. 
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Figure 2-5.  SQL Server Restore file screen 

 
The next step in the process is to create a number of folders for the PATH/AWARE software.  At 
the C:/ level create the following folders: PATH-AWARE; GISCache; and GISDATA.  Enter 
into the GISDATA folder.  Create a subfolder called: WMK.  This folder will house the stand-
alone map suite data for the United States that is supplied by  ThinkGeo.  Insert the disk with the 
ThinkGeo map suite and view the files on the disk.  The files should look like those shown 
below: 
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Figure 2-6.  Select File screen 

 
Double-click on the file WorldMapKitData.part001.exe to execute it.  This action will begin an 
installation process to unzip all of the map files.  When asked for the destination file, browse the 
file folders until you locate C:\GISDATA\WMK and select it, as is shown in the following 
screen: 
 

 
 

Figure 2-7.  GIS Map install screen 

 
The application will prompt the user for the second disk when it has finished installing files from 
the first disk. 
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Next, all of the PATH/AWARE files from the DVD with the application files need to be copied 
to the C:\PATH-AWARE folder. 
 
At this point, all of the files necessary to run the PATH/AWARE tool have been installed.  The 
user may want to create a shortcut of the PATH-AWARE.exe file to put on their desktop for easy 
access to launching the application. 
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3. USING THE PATH/AWARE SOFTWARE 

This section of the guide will step the user through the basics of using the PATH/AWARE 
software.  The intent of this section is to make the user aware of the basic functionality of the 
code.  More detailed instructions and software documentation is under development in a 
companion document that will serve as a user‟s manual. 
 
3.1. Getting Started 
 
To get started, locate the PATH-AWARE.exe file or a shortcut and double-click on it to launch 
the application.  The first screen should look like this: 
 

 
 

Figure 3-1.  PATH-AWARE start-up pop-up screen 

 
If scenarios had already been saved, the user can access then through the Open option.  The first 
time using PATH\AWARE, select New.  The next pop-up window should look something like 
this: 
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Figure 3-2.  PATH-AWARE start-up SQL Server screen 

 
There are three tabs in this window.  The Server tab is most important the first time 
PATH/AWARE is put into use.  The user must type in the name of the SQL Server and then 
click on Connect to access the databases (Note: do not click on OK at this time).  The name of 
the SQL Server was displayed during the SQL installation process (noted above during the SQL 
Server installation process).  If the user does not know the SQL Server name, launch the SQL 
Server Management Studio software from the Start menu and observe the SQL Server name that 
comes up in the first window of that application, as shown in the following pop-up: 
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Figure 3-3.  PATH-AWARE SQL Server connect screen 

 
Once the user has typed in the Server name into the PATH\AWARE intro screen the software 
will remember this configuration for future access.  It is also important to note that because the 
SQL Server software can be accessed across a network, the database files could be installed on a 
remote server and accessed through the network.  This affords the users the ability to share 
scenarios on a common server.  Otherwise sharing scenarios becomes more problematic.  There 
are some import/export features in PATH/AWARE to accommodate some limited sharing, but 
not for complete scenarios at this time. 
 
Next, the user should click on the tab for Asset & Building Databases, as shown in the following: 
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Figure 3-4.  PATH-AWARE Asset & Building Databases screen 

 
There should be only one choice for an Asset Database.  The Building Database choices will 
depend on how many HAZUS databases were selected when attaching databases.  The Emporis 
database contains building specific information (typically obtained from county tax assessors), 
but only for a limited number of areas around the country (e.g., the King and Pierce County 
region around Seattle, the four counties in the Denver area, and a few areas in the National 
Capital Region).  Where the user wants to run a scenario will likely be the basis for which 
Building Database to select.  If the user wants to run a scenario in an area where building 
specific data exist, there will be more fidelity in the analysis.  Running scenarios with HAZUS 
data relegates the analysis to information supplied at a census block level.  For the purpose of 
getting a quick start on using PATH/AWARE, select the Emporis Building Database and then 
click OK. 
 
The next pop-up screen allows the user to select the background map coverage for the GIS 
display, either the Google Map option (you must have Internet access) or the stand-alone 
ThinkGeo maps, as shown in the following: 
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Figure 3-5.  PATH-AWARE map selection screen 

 
 
For the purpose of this Quick Start, select the Standalone map data option and click OK. 
 
The main PATH/AWARE screen now displays on the computer monitor, as shown below: 
 

 
 

Figure 3-6.  PATH-AWARE initial GIS map screen 

 
The main part of the screen is the GIS map window.  At the very top of the window are a number 
of drop-down menus.  Below the drop-down menus are several icons and user-selectable options 
for quick access to certain functional aspects of the code.  To the right there is a pane with 
several tabs that allows the user to manipulate the display in the GIS map window.  At the 
bottom of the main window are several fields that identify information about the server and 
databases being used for this scenario analysis.  A brief introduction to each of these facets of the 
code will be provided. 
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3.2. Setting up a Scenario  
 
The first thing the user should do when beginning a new scenario analysis is to name the 
scenario.  To do this, select the View drop-down menu, and the AWARE option.  The screen 
should now look like this: 
 

 
 

Figure 3-7.  AWARE Scenario screen 

 
The left side of the screen shows selections for processes associated with a consequence 
management analysis (e.g., screening sampling, characterization sampling, waste handling and 
disposal, decontamination, and clearance sampling).  Make sure Scenario is selected in the left 
side tree, then type in a name of the scenario in the parameter box to the right.  To save, click on 
the File menu and select Save.  
 
There is no need to step through the inputs to the consequence management options until a 
spatial domain of a scenario is formulated.  Therefore, the user should go back to the map view.  
To do this click on the Window drop-down menu and select Map.  The GIS map window will 
now reappear. 
 
The user will now need to zoom into the locale that they wish to do a scenario analysis on.  
There are several pan and zoom icon options at the top of the window to navigate to the desired 
location and extent of view.  The user can also hold down the Shift key and then depress the left 
mouse bottom while dragging diagonally across the screen, which will cause a rectangle to be 
drawn signifying the zoom extent.  Zoom into the Seattle, Washington area to create a view that 
looks like the following: 
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Figure 3-8.  PATH/AWARE specific location map 

 
Next, an area of interest will be created.  PATH/AWARE has the ability to create an area of 
interest by importing a shape file that defines contour intervals or by allowing the user to create a 
series of polygons representing the area of interest. 
 
A shapefile may have been created by another program that estimates the aerosol deposition of a 
contaminant, such as a CBR agent.  At the top of the window is a selection for Import.  Under 
Import are two choices: Shapefile as overlay; and Shapefile as zones.  Shapefiles may have 
different projections, so the user needs to know what projection the file represents.  Shapefiles 
may be brought in as zones, in which case the user specifies whether each contour in the 
shapefile represents a red, yellow or green zone.  Red zones signify highly contaminated areas, 
yellow zones moderately contaminated areas, and green zones insignificantly contaminated 
areas.  Once the assignment of red/yellow/green zones has been made during the import setup, 
the PATH/AWARE tool mines the underlying database for these areas to retrieve building and 
critical infrastructure data for the areas.  PATH/AWARE mines data only for red and yellow 
zones, but not green zones.    Alternatively, the shapefile can be brought in as an overlay and 
then the user can create polygons that will be used to mine the building and asset data.  This is 
preferable when there is a significant amount of area that will not be part of the consequence 
management analysis, such as an area extending over a water body.  For this Quick Start activity, 
the shapefile import feature will not be performed.  Instead a couple of polygon zones will be 
created. 
 
To create a red, yellow or green zone, select the icon at the top of the screen that shows a red, 
yellow, green polygon with a plus symbol embedded in it.  A pop-up occurs on the screen with a 
Done button.  The user is in polygon insert mode until the Done button is clicked.  Polygons are 
created by using the mouse to navigate the cursor to selected locations where a polygon node is 
desired, then the left mouse button is clicked once to locate the node.  If the user needs to pan 
and zoom during this operation they should bring the mouse cursor to the pan and zoom icons at 
the top of the window.  Straight line segments are drawn by the application between each 
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successive polygon node.  When the user gets to the last polygon node location, the left mouse 
button is clicked twice in rapid succession.  This will close the polygon and a pop-up will occur, 
as shown below: 
 

 
 

Figure 3-9.  Zone naming screen 

 
 
The user should give the zone a unique name and designate whether it is a red, yellow or green 
zone, then click OK.  The yellow zone created for this example looks as follows: 
 

 
 

Figure 3-10.  Zone polygon example 

 
 
If the zone does not show on the map, make sure the appropriate zone (e.g., red, yellow, or 
green) is check-marked in the tree on the right in order for it to display in the window.  Next, the 
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user should construct a red zone within the yellow zone.  The PATH/AWARE software will 
automatically delineate the difference between any two zones that are overlapping.  To create the 
red zone, the user must click the Add Zone icon again. Then the same polygon creation method 
is used.  The corresponding red zone for this example is shown in the following: 
 

 
 

Figure 3-11.  Multiple zone example 

 
Upon completion of the red zone, click the Done button in the pop-up.  A new prompt will 
appear to confirm that the user wants to discontinue polygon generation and to proceed to mining 
data within these prescribed zones, as shown in the following: 
 

 
 

Figure 3-12.  Zone polygon completion pop-up screen 

 
Click on Yes.  It may take some time for the PATH/AWARE tool to mine the data, depending on 
the size of the polygon and the number of buildings within these zones. 
 
It is advisable to do frequent saves of the scenario.  Either select Save from the File drop-down 
menu, or perform a short-cut with a <ctrl> S key stroke. 
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There are some desirable features of the GIS engine that can be used to gain situational 
awareness.  Try checking the Critical Infrastructure selection in the Layers tab within the right 
pane of the window.  All the Critical Infrastructure locations, along with associated icons for 
their type, are displayed.  Alternatively, individual in Infrastructure types can be checked (e.g., 
hospitals).   
 
Next click on the Services tab.  A list of services appears in the right pane.  The services are 
color-coded according to whether they are not impacted (green), moderately impacted (yellow), 
and severely impacted (red).   
 
Next, click on the Assets tab.  Assets within the yellow and red zones are displayed, and colored 
according to their location.  By clicking on an asset in the list, the location will be displayed on 
the map as red star.  For those assets with a plus sign adjacent to the name it indicates that there 
are dependent assets that are associated with that asset.  The dependent assets show up as blue 
diamonds on the GIS map window.   
 
By right-clicking on an asset in the tree several other options become available.  The Properties 
selection is important because it contains data essential to developing timelines and costs 
associated with restoring assets. 
 
Next, click on the Zones tab.  The red and yellow zones are shown in the pane.  Each one 
defaults to a Remediation Unit number, according to the order in which it was created.  So 
Remediation Unit 1 (RU1) is the yellow zone, the first one created.  Right-click on the 
YellowZone name and a few additional options are available.  Choose the Properties option and a 
new pop-up is displayed, as shown below: 
 
 

 
 

Figure 3-13.  Zone properties pop-up screen 
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The window shows that the total area for the YellowZone is 2.5 square miles.  Click on the 
Remediation Units tab and the following is shown: 
 

 
 

Figure 3-14.  Zone remediation unit properties tabs 

 
Indoor and outdoor areas are summarized in this window.  Click on the Buildings tab and a 
complete listing of the buildings in this zone are displayed, along with the name and attributes of 
the buildings.  The contents of this window can be copied and pasted into an Excel spreadsheet if 
desired.  The following graphic shows the contents of the Buildings tab: 
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Figure 3-15.  Zone buildings properties tabs 

 
In the right pane under the YellowZone and RedZone are the RU1 and RU2 designations with a 
plus sign next to them.  Clicking on the plus sign reveals a list of all of the critical infrastructure 
assets within that Remediation Unit.  Clicking on any one of the assets will display its location 
on the map. Clicking once on any of the RUs in the list will highlight it on the map. 
 
The Remediation Unit concept was intended to help manage the flow of resources for 
consequence management activities.  When a red or yellow zone is created it is designated as a 
Remediation Unit.  Each zone can be subdivided into multiple Remediation Units.  Conceptually 
during a cleanup operation there may be limited resources.  Resources would be assigned to a 
geographic area to perform their various tasks (e.g., sampling, decontamination) and when done 
move on to the next area.  There is a notion that 4 to 6 city blocks might constitute a reasonable 
area for the congregation of a set of resources to facilitate the optimal staging of equipment and 
resources prior to moving them to the next area of interest.  So the user can help facilitate a more 
realistic scheduling of activities and resource movements by subdividing zones into multiple 
Remediation Units.   
 
To create additional Remediation Units in a zone, right click on the zone name (e.g., RedZone) 
and choose Add Remediation Unit.  Now create a polygon within the red zone the size of interest. 
When creating a Remediation Unit the user can start the polygon outside the zone of interest and 
overlap the boundaries in order to make sure that it captures the zone boundaries.  The 
PATH/AWARE software will automatically truncate the polygon to the proper boundaries which 
will act as sides to the new polygon.  Additional Remediation Unit polygons can be drawn and 
overlap with existing polygons, which will truncate to the existing boundaries that are adjoining, 
as seen below (note overlap): 
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Figure 3-16.  Creating remediation unit polygons 

 
When it is truncated to the existing Remediation Unit boundaries it then looks like this: 
 
 

 
 

Figure 3-17.  Completed remediation unit polygons 

 
When satisfied with the completion of the Remediation Units click Done in the pop-up window 
and then Yes in the subsequent pop-up window confirming that the database will be mined again 
to differentiate the new Remediation Unit attributes.  Now expanding the RedZone Remediation 
Unit designation in the pane on the right reveals additional Remediation Units.  These can be 
renamed with a right-click on the RU name. 
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Another aspect of situational awareness can be viewed by going back to the AWARE module.  
Click on the Window drop-down menu and select AWARE.  In the window pane on the left under 
General select Zones.  The main window now shows a synopsis of information about the red, 
yellow and green zones.  At the top of the window is the total area in square miles for each zone.  
In the center of the screen is a summary of building information for the red and yellow zones, 
including the number of buildings in each usage category (e.g., residential, commercial, mixed 
(residential and commercial), industrial, and public (governmental), as well as totals.  In addition 
are the square footage of indoor space and percentages.  At the bottom of the window are 
statistics on assumed indoor contamination potential.  For the purpose of assigning 
decontamination criteria there needs to be an assignment of the degree of indoor contamination 
which is assumed to follow a normal distribution and is assigned randomly to all buildings in the 
area of interest.  The following shows an example of this Zone table: 
 

 
 

Figure 3-18.  Deposition Zone statistical summary screen 

 
The tables show that for this roughly 3 square miles of area in Seattle over 3,000 buildings and 
over 75,000,000 square feet of indoor area are potentially affected within the red and yellow 
zones. 
 
3.3. Using the AWARE Module 
The PATH/AWARE tool assigns default parameter values to the various inputs needed to 
perform an analysis in order to develop cost estimates and timelines for a wide-area consequence 
management effort.  Some of these parameters are based on input from Subject Matter Experts, 
or from a review of the literature and/or vendors.  A summary of the parameter definition work is 
being prepared for inclusion in a user‟s manual for the code. 
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Resources 

Inputs are prescribed mainly through the various consequence management tasks identified on 
the left pane of the AWARE module.  Click on Sampling under the Resources heading in the left 
pane.  The screen should look much like the following: 
 

 
 

Figure 3-19.  Sampling input screen 

 
The user has a number of entries in this input screen to consider; inputs that may greatly affect 
the time and cost of the consequence management activities.  All input parameters with a white 
fill may be modified by the user.  Those with a gray fill are calculated based on the user inputs.   
 
For some scenarios there may be real-time sampling or detection devices available for 
characterizing the nature and extent of contamination.  Radiation detection devices come in a 
number of configuration and measure various parameters of interest.  There are some chemical 
detectors available for a limited capability on quantifying chemical concentrations.  Most of the 
biological detection capability is deficient in terms of detection limits, so it is not likely that real-
time sampling would be viable for biological release scenarios.  For the chemical and 
radiological scenarios, the user can specify the percentage of samples collected that will either be 
real-time sampling or physical sampling leading to laboratory analysis.  The real-time sampling 
precludes laboratory analysis, which can be limiting depending on laboratory availability and 
throughput rates. 
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Some key parameters in the PATH/AWARE code may be specified with a temporal component.  
For Sampling Teams input, there is a parameter for Number of teams.  To the right of this input 
line is a link for Edit.  Clicking on this link produces the following pop-up: 
 

 
 

Figure 3-20.  Time-dependent input screen 

 
The user may add any number of time dependent steps to the resource loading of the number of 
sampling teams.  This is basically a step function.  The user specifies the start day for a new 
number of teams, whether it is more or less than the previous step does not matter.  The number 
of teams available is constant between steps and constant throughout the remainder of the 
consequence management effort for the last step.  This time-dependent input can be toggled on 
or off with the check box next to the Edit link on the Sampling Teams input screen. 
 
PATH/AWARE has decision rules built in for developing timelines and allocating resources.  
Some of these decision rules have parameters that can be modified by the user.  The user can 
access these parameters from the Advanced drop-down menu and selecting the Advanced 
Settings option.  The pop-up window should look like the following: 
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Figure 3-21.  Advanced Settings Scheduling screen 

 
The user has some control over the number of sampling teams utilized for both indoor and 
outdoor sampling, as well as the relative priority of assigning sampling teams to clearance versus 
characterization sampling. 
 
The next input parameter screen is the Lab option under Resources.  The Lab screen appears as 
follows: 
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Figure 3-22.  Lab capacity screen 

 
The choices on this screen are a bit misleading and an artifact of the early work on 
PATH/AWARE that focused on biological release scenarios.  There are two laboratory analysis 
methods listed, PCR and Culture.  These are two primary laboratory analysis methods used for 
biological characterization.  The PATH/AWARE code does not actually parse out these analyses 
separately, although some thought was given to that early on, hence the nature of separating the 
two.  PATH/AWARE merely tallies up the sum of the two throughput rates and makes that the 
total for the analysis.  So even for chemical and radiological scenarios, the nature of the 
laboratory analysis is not relevant to the code, just the throughput rates for whatever kind of 
analyses are prescribed.  Keep in mind that PATH/AWARE is considered a planning tool, so 
prescribing a total throughput is appropriate.  If PATH/AWARE were to be enhanced in the 
future to be more of an operational tool, then greater specificity on laboratory analyses and 
throughputs would likely be in order.  Laboratory throughput is typically a critical parameter to a 
scenario analysis.  These parameters may also have a temporal input if desired. 
 
Screening 

The next input construct to consider is Screening, both for Outdoor and Indoor.  The concept 
here is fairly simple; there will likely be a need for some fairly quick sampling after a large scale 
release to define the nature of the release in terms of spatial extent and to what degree 
contaminants have infiltrated into buildings.  Models may be used to predict deposition, but the 
Unified Command is likely to want confirmation in terms of some degree of physical sampling 
and/or real-time detection.  The Outdoor input screen looks like the following: 
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Figure 3-23.  Outdoor Screening sampling screen 

 
Conceptually, the Outdoor screening is input as a grid-sampling scheme, where the user specifies 
the area that each sample will cover in a grid cell, and the number of grid cells will be dependent 
on the total area of the red, yellow, or green zones.  The input screen shows the total number of 
samples that result from the specification of a sampling density.  The user may want to gauge the 
screening effort more on the basis of the total number of samples than on the sampling density, 
but that is easy enough to manipulate with the way the input is constructed.  The user may want a 
different density or number of samples in each of the different zones as well. 
 
For the Indoor screening input, the screen looks as follows: 
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Figure 3-24.  Indoor Screening sampling screen 

 
The concept for Indoor Screening Assessment is that there may be a triage method used to 
determine the severity of the infiltration of contaminants into buildings.  Work has been done to 
define a triage method of sampling around building entrances, windows, and facets of the heating 
and cooling system (e.g., return flow vents, the filters in the intake and exhaust for the heating 
and cooling system).  This data, from an operational perspective, might guide the nature of the 
characterization effort and whether decontamination would be needed and to what extent.   
 
Characterization 

Next in the process of consequence management activities is Characterization sampling, both for 
Outdoor and Indoor.  The following figure shows the options for this module: 
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Figure 3-25.  Outdoor Characterization sampling screen 

 
For characterization sampling the user has a couple of options.  They can choose judgmental 
sampling or statistical sampling design.  The judgmental sampling is basically allowing 
professionals to decide how many samples to collect and where to place them.  This was 
basically the process used during the response and recovery activities following the 2001 anthrax 
letter attacks.  In 2005 the Government Accountability Office (GAO) critiqued the anthrax 
response and recovery activities (GAO, 2005).  One of their key criticisms of the effort was the 
lack of a statistical, or probabilistic, sampling design method.  This was mainly aimed at the 
clearance sampling phase.  Nonetheless, the GAO stated that the judgmental process did not lend 
itself to making any assertions about the confidence in the overall cleanup process.  With the 
application of statistical design methods there is a recognition that confidence statements can be 
made about the cleanup process.  Methods can be employed that allow the sampling design 
criteria to yield a statement such as: with this many samples there will be 95% confidence that 
95% of the area is clean.  The confidence levels and probabilities are set by the user, preferably 
with assistance from the Unified Command.  A statistical design method was employed in the 
PATH/AWARE tool in order to give the user a means of evaluating the effects of a confidence-
based sampling plan.  The user can choose to do only judgmental, only statistical, or a 
combination of judgmental and statistical sampling design.  Under most circumstances it is not 
likely that a statistical design will be used for characterization sampling.  It is, however, likely to 
be considered for clearance. 
 
The statistical design method employed for the Characterization sampling module in 
PATH/AWARE is the Upper Tolerance Limit (UTL) method.  This method does not explicitly 
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account for spatial variability of the distribution of the contamination.  It is just a statistical 
method based on the underlying statistical distribution of the data and an assumed zone size.  
The assumed zone size is, for all intents and purposes, a judgmental assumption.  In an 
operational context, zone sizes would be established for all outdoor and indoor areas.  For a 
planning tool like PATH/AWARE, however, this would be extremely cumbersome.  Therefore, a 
default zone size is established for outdoor and indoor sampling.  These zone sizes may be 
changed by the user by clicking on the Advanced drop-down menu and selecting Advanced 
Settings.  The following pop-up will appear, and the user should click on the Statistical Sampling 
tab. 
 

 
 

Figure 3-26.  Advanced Settings Statistical Sampling screen 

 
For indoor sampling, the user can set the indoor block size, or zone size, for each usage category 
(e.g., Residential, Commercial, Industrial, Mixed, and Public).  Each building has a total square 
footage of indoor space.  The number of zones in a building will be the total square footage 
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divided by the indoor block size, or zone size.  By example, if the indoor block size is 4,000 
square feet and the total building size is 8,000 square feet, then there would be two zones in this 
building.  The statistical sampling algorithm determines the number of samples per zone for a 
give confidence/probability goal.  For instance, if the result of the statistical sampling algorithm 
was 40 samples for a given confidence/probability goal, then this building would require 80 
samples because it has the square footage to require two zones worth of sampling.  Any partial 
square footage left over from dividing out the indoor block size is treated proportionally. 
 
For the indoor sampling, the user has the option to specify different confidence/probability goals 
for the different usage types.  In this manner, relative risk can be accounted for.  The user may 
want greater confidence in the sampling results for residential usage, for instance, where children 
and the elderly may have greater exposure and risk than in say an industrial setting. 
 
It should be noted that PATH/AWARE has to step through the resource allocations while 
systematically addressing every building within a zone or remediation unit.  Therefore, the code 
ranks the building sizes in a zone or remediation unit and applies resources to the largest building 
first and then systematically works through the rest of the buildings in order. 
 
Waste 

The waste handling and disposal module in PATH/AWARE is patterned after the logic and data 
used in the US Environmental Protection Agency‟s (USEPA) online tool called:   Incident Waste 
Assessment & Tonnage Estimator (I-WASTE).   
 
A fact sheet for I-WASTE can be found at the following web site: 
http://www.google.com/url?sa=t&rct=j&q=paul%20lemieux%20epa%20waste%20calculator&s
ource=web&cd=1&ved=0CEgQFjAA&url=http%3A%2F%2Fcfpub.epa.gov%2Fsi%2Fsi_public
_file_download.cfm%3Fp_download_id%3D505320&ei=r1X3T4W7EKbs2gXc07TDBg&usg=
AFQjCNFvwO7dt0JivVJ9rzEF_j7y_QEfDw 
And the tool itself can be accessed at: 
www2.ergweb.com/bdrtool/login.asp 
 
The user is encouraged to familiarize themselves with the I-WASTE tool prior to using the waste 
handling and disposal module of the PATH/AWARE tool in order to learn about this 
functionality. 
 
Several input categories are available in the Waste module, including Sampling Resources, 
Outdoor, Indoor, Decon Clearance, and Transport, are available to the user.  The following 
figure shows the Summary screen from the Waste module: 
 

http://www.google.com/url?sa=t&rct=j&q=paul%20lemieux%20epa%20waste%20calculator&source=web&cd=1&ved=0CEgQFjAA&url=http%3A%2F%2Fcfpub.epa.gov%2Fsi%2Fsi_public_file_download.cfm%3Fp_download_id%3D505320&ei=r1X3T4W7EKbs2gXc07TDBg&usg=AFQjCNFvwO7dt0JivVJ9rzEF_j7y_QEfDw
http://www.google.com/url?sa=t&rct=j&q=paul%20lemieux%20epa%20waste%20calculator&source=web&cd=1&ved=0CEgQFjAA&url=http%3A%2F%2Fcfpub.epa.gov%2Fsi%2Fsi_public_file_download.cfm%3Fp_download_id%3D505320&ei=r1X3T4W7EKbs2gXc07TDBg&usg=AFQjCNFvwO7dt0JivVJ9rzEF_j7y_QEfDw
http://www.google.com/url?sa=t&rct=j&q=paul%20lemieux%20epa%20waste%20calculator&source=web&cd=1&ved=0CEgQFjAA&url=http%3A%2F%2Fcfpub.epa.gov%2Fsi%2Fsi_public_file_download.cfm%3Fp_download_id%3D505320&ei=r1X3T4W7EKbs2gXc07TDBg&usg=AFQjCNFvwO7dt0JivVJ9rzEF_j7y_QEfDw
http://www.google.com/url?sa=t&rct=j&q=paul%20lemieux%20epa%20waste%20calculator&source=web&cd=1&ved=0CEgQFjAA&url=http%3A%2F%2Fcfpub.epa.gov%2Fsi%2Fsi_public_file_download.cfm%3Fp_download_id%3D505320&ei=r1X3T4W7EKbs2gXc07TDBg&usg=AFQjCNFvwO7dt0JivVJ9rzEF_j7y_QEfDw
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Figure 3-27.  Waste Disposal summary screen 

 
 
Decontamination 

The decontamination module has numerous options for planning the cleanup portion of 
consequence management activities.  The approach to decontamination planning has a number of 
assumptions. Outdoor decon, for instance, occurs before indoor decon (to limit fomite transport). 
Buildings are characterized as small, medium or large for the purpose of scoping fumigation 
resources and time (the user sets the specifications). The degree to which a building is 
contaminated is assumed to have some relationship with whether surface treatment or fumigation 
will be employed.  No reasonable modeling and simulation approach has been able to 
demonstrate a capability to predict the degree of contamination in buildings due to infiltration 
through ventilation systems, doorways and windows, as well as fomite transport.  The amount of 
particulate infiltration into buildings is highly uncertain. It is assumed that some buildings will 
be more contaminated than others.  The decon techniques selected may be dependent on the 
degree of building contamination.  Therefore, PATH/AWARE, as a planning tool, needs a way 
to address different strategies for decontamination for differing levels of building contamination. 
The relative degree of contamination in buildings is assumed to be a normal statistical 
distribution.  PATH/AWARE randomly assigns the degree of building contamination to every 
building in the red and yellow zones, while preserving the overall normal distribution, as shown 
in the figure below.   
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Figure 3-28.  Relative Degree of Conatmination in Buildings 
 

User supplied metrics determine the selection of surface treatment versus fumigation based on 
degree of contamination. The yellow vertical lines in the figure illustrate the concept of user-
defined thresholds for prescribing surface treatment and fumigation.   In addition, the user has 
multiple treatment technologies that can be prescribed for indoor decontamination. 
 
The following figure shows the screen for outdoor decon. 
 

 
 

Figure 3-29.  Outdoor Decon screen 
 
The user has the ability to specify the rate that the decon treatment is applied, the number of 
treatment units, and cost.  It also allows the user to specify the percentage of the area to be 
cleaned, because not all areas may need to be deconned (e.g., open water bodies).  Similar 
screens exist to specify decon parameters for indoor contamination according to usage (e.g., 
residential, commercial, etc.).   
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The user can set which indoor decon methods to use at which degree of contamination, as shown 
in the tab for Decon Method Assignments & Thresholds: 
 

 
 

Figure 3-30.  Decon Method Assignments & Thresholds screen 

 
The user can also set criteria for the size of the buildings, classifying them as small, medium or 
large.  This criteria influences the size of the fumigation generators needed to decon each 
building when fumigation is invoked. 
 
There is also a tab for Self, which refers to the concept of self-decontamination.  Self-
decontamination applies only to residential buildings.  The user can specify what percentage of 
residential buildings will be deconned by the owner or a hired contractor.  This takes the decon 
part of the process out of the timelines and costs for residential cleanup when invoked.  It is only 
for the decon process, though, and not for any sampling and waste removal that may have been 
specified. 
 
Clearance 

Clearance sampling is similar to characterization sampling in that both judgmental and/or 
statistical sampling design may be invoked.  For indoor clearance sampling, the user can specify 
sampling criteria for each decon method employed and for each building usage type (e.g., 
residential, commercial, etc.).  The statistical or probabilistic method used for clearance sampling 
is different from that employed in the characterization module.  For clearance sampling a 
compliance sampling technique is employed to derive appropriate sampling numbers for user 
specified confidence/probability goals. It should be noted that PATH/AWARE does not start 
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clearance sampling when constructing a timeline until decontamination is complete. The 
following screen is an example of the indoor clearance sampling parameter inputs: 
 

 
 

Figure 3-31.  Indoor Decon Method screen 

 
Schedule Timelines 

Once the user has entered parameters for all of the consequence management tasks, they can 
view the calculated timeline for accomplishing the cleanup work.  Select the View drop-down 
menu and Schedule Timelines from the list.  A timeline showing the major activities for each 
Remediation Unit or Zone is then displayed, as shown below: 
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Figure 3-32.  Predicted timelines for multiple remediation units 

 
A very informative graphic that the user has access to deals with the utilization of key resources.  
Click on the RU Resource Summary tab and a graphic similar to this will appear: 
 

 
 

Figure 3-33.  Resource utilization 

 
This graphic shows some of the major activities associated with consequence management along 
the x-axis.  The y-axis shows a Portion of Total Time.  Any bar graphs with red fill signify non-
optimal utilization of resources.  The red fill corresponds to the portion of the total time that the 
resources for these tasks are 100% utilized.  For instance, the Analysis task (i.e., laboratory 
analyses) is 100% utilized for 100% of the time.  One could conclude that additional laboratory 
analysis capability could lead to shortening the overall timeline.  The Sampling resources in this 
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example are 100% utilized for 62% of the time.  Therefore, additional sampling resources might 
also shorten the timeline.  Once additional resources are added, however, the interdependencies 
amongst the parameters may lead to shortages elsewhere in the timeline.  The user must be 
careful not to input unreasonable assignments for the number of resources in a given area for the 
sake of reducing the timeline. 
 
Cost 

PATH/AWARE also summarizes the cost associated with the consequence management 
activities.  From the View drop-down menu select Cost.  The following figure shows an example 
of a cost plot: 
 

 
 

Figure 3-34.  Bar graph of cost estimates 

 
 
There is also an option with the tab to display a pie chart of the cost results: 
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Figure 3-35.  Pie chart of cost estimates 

 
 
Reports 

PATH/AWARE has the ability to produce two output reports for the AWARE analyses.  One 
report summarizes the input parameters and the other summarizes output of the model.  Both 
reports are accessed from the View drop-down menu. The following figure shows an example of 
a page from the Inputs Report: 
 

 
 

Figure 3-36.  Input summary report 
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The user can save these reports in a number of formats, including PDF, CSV, Excel, Rich Text 
Format (RTF), TIFF file, and Web Archive. 
 
Exporting and Importing Zones and Remediation Units 

A convenient feature of the PATH/AWARE tool is its ability to export any zones or Remediation 
Units that have been created.  This makes it relatively easy to start a new scenario with the same 
basic zones of interest.  This functionality is accessed from the Export drop-down menu and 
selecting the Shape Files option, and then the Zones or Remediation Units options.  This 
functionality can also be accessed from a drop-down menu just above the Map window labeled 
Export.  In order to import these zones or Remediation Units into a new scenario the user should 
access the Import drop-down menu just above the Map window. 
 
Other Features of Note 

There are some other features of note that the user may want to utilize.  From the Map window 
there is a drop-down menu for Preferences.  One of the tab choices from the pop-up window is 
Initial Layers.  The following shows the contents of this pop-up window: 
 

 
 

Figure 3-37.  Map preferences 

 
The user can select which GIS map features are displayed at startup time from this menu.   
 
Another feature of note is the Legend pop-up window accessed from the Map drop-down menu 
with that name that describes icons and color schemes, as shown in the following: 
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Figure 3-38.  Map Legend 

 
 
 
3.4. Using the PATH Module 
The PATH module is intended to provide an objective means of prioritizing the consequence 
management efforts for critical infrastructure assets and services.  The process of prioritizing 
critical infrastructure needs generally follows the following steps: 
 

1. Identify critical assets and status within the impacted area. 
 

2. Refine asset status (e.g., impacted or not) based on ground truth information. 
 

3. Assess the status of critical services within a defined area of interest. 
 

4. Refine service status based on ground truth information. 
 

5. Identify the critical assets that provide each service. 
 

6. Identify the asset dependencies for those assets. 
 

7. Add asset data that is scenario specific e.g., asset milestones and subjective 
considerations. 

 
8. Add service data that is scenario specific e.g., service milestones and desired status. 

 
9. Set objectives, function, and service recovery weightings based on situational awareness 

and user input. 
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10. Output service priorities based on service status, desired status, weightings, and 

subjective considerations. 
 

11. Output asset priorities based on asset status service priorities, desired service functional 
thresholds, dependencies, and subjective considerations. 

 
12. Validate service and asset priorities by looking at the justification column and 

dependencies viewer. 
 

13. Assess restoration timelines and consequences (utilizing AWARE). 
 

14. Refine prioritization strategy to achieve restoration milestones. 
 

15. Output summary documentation i.e., slides and report. 
 
Before even launching the PATH module the user should look at the critical assets associated 
with their scenario.  To do this, go to the Map window.  On the right side pane there is a check 
box for Critical Infrastructure.  Check this box on and all of the Critical Infrastructure locations 
in the area will display on the map with an icon associated with the type of service the asset 
provides.  In order to keep this document from being sensitive, a visual graphic example of this 
functionality is not presented.  The user can toggle any of the services listed under Critical 
Infrastructure, such as Fire or Police, if that is all that want to view at a given time.  Another way 
to view Critical Infrastructure is to click on the tab in the right pane for Assets.  This tab will 
show a listing of all of the Assets located in the zones that were prescribed.  If the user clicks on 
one of the Assets listed a location shows on the map for that Asset (as a red star).   There may be 
other icons displayed on the map as blue diamonds.  These represent dependent Assets.  A 
dependent Asset will also appear in the tree in the right pane as a sub-tier listed Asset by 
expanding the „+‟ icon next to an Asset name. 
 
In order to get representative priority rankings of the Assets, and to provide reasonable estimates 
of restoration and recovery timelines and costs for an Asset, the user must enter parameter values 
for each Asset.  Depending on the number of Assets in the zones of interest, this could take some 
time.  In order to facilitate entry of the required parameter data the user should double-click on 
an Asset in the right pane.  This action brings up a pop-up window that looks like the following: 
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Figure 3-39.  General Asset Attribute pop-up window 

 
The screen shows a number of parameters that can be input, such as the outdoor area to be 
cleaned, the functionality of the facility on a percentage basis, and whether it needs to be restored 
by a certain milestone date.  The Category for the service provided by the Asset is also shown as 
a drop-down selection.  The tab for Buildings should be selected next.  This looks like the 
following: 
 

 
 

Figure 3-40.  Building Asset Attribute pop-up window 
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In this tab the user should input the total indoor area of the building (in square meters) as well as 
the number of floors of the building.  In addition to some of these physical properties the user 
can also set dependencies by right-clicking on the Asset name in the right pane and selecting 
Asset Dependencies.  They can also edit the Services provided by the Asset by right-clicking on 
the Asset and selecting Services.  This produces a pop-up window that looks something like this: 
 

 
 

Figure 3-41.  Services pop-up window 

 
The user selects a service and then clicks on one of the two arrow icons in the middle to move to 
the Services Provided or Services Not Provided category.   
 
It should also be noted that there is a Services tab in the right pane of the window that when 
selected will display all of the services in the area color-coded to functionality.  A red text means 
the service has been highly degraded and may not be functional, a yellow text represents a 
service that may be impaired, and a green text represents a service that has not been negatively 
impacted. 
 
PATH is accessed from the VIEW drop-down menu.  The first screen for PATH looks basically 
like this: 
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Figure 3-42.  PATH weighting of prioritization objectives and functions 

 
The user can drag the slider bars to set the priorities (i.e., low to high in 5 distinct increments) for 
each of the objectives (e.g., Maintain Economy) and Functions (e.g., Commerce), as well as the 
services in the right side of the window.  This should be a systematic approach on the part of all 
decision makers to assign priorities or weightings to each of these criteria.  At different stages of 
the restoration and recovery process the objectives may change and therefore priorities for 
critical infrastructure may change as well. 
 
Next the user should consider defining the functionality of the services.  Click on the tab called 
Input Services Data and a screen similar to the following should be displayed: 
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Figure 3-43.  Functionality of Services 

 
In this screen the user can change a number of parameters associated with functionality including 
what metric is used to establish priorities, the current status of the services functionality, the 
desired status of functionality, and a milestone date.  The user can also check a box that says Has 
Workaround.  With this box checked it implies that the services could be obtained elsewhere and 
that nothing needs to be done to restore this service. 
 
The next screen of interest to the user is the tab titled Input Asset Data.  This screen is similar to 
the Input Services Data tab wherein it allows the user to specify functionality data relative to 
specific Assets.  This screen is not shown here in order to avoid any sensitivity issues about 
specific Assets.  This screen also allows the user to check some boxes that provide additional 
info about the individual Assets, such as: Has Workaround, Is Unique, Is Health Risk, Has 
Political Considerations.  The Has Workaround selection removes the Asset from prioritization 
consideration.  The other three selections automatically position the Asset to the top of the list 
regardless of other weighting and dependency selections. 
 
Once all of the specifications have been made to define the attributes of the services and Assets, 
and the weightings done, the user then clicks the two buttons at the top of the screen to 
Recalculate Assets and to Recalculate Service Status.  Then the user can click on Output: Service 
Prioritization and Output: Asset Prioritization.  In these two windows the user will see a rank 
ordered listing of the priorities for service restoration and Asset restoration.  In addition, the user 
is provided additional information to help understand the ranking.  A Reason column tells 
whether a service or an Asset was a direct Contribution to Priorities, or whether it was Enabling 
as a dependency or if it is already Fully Functional.  There are columns showing the ranking 
scores and dependency scores as well. 
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A useful tool within PATH is the Dependency Viewer.  This functionality is accessed from the 
button at the top of the screen.  The Dependency Viewer screen is essentially blank when first 
accessed.  On the upper left of the screen is a drop-down list of services.  Select one of the 
services then click the Generate button.  A graphic will appear that shows interdependencies 
amongst services, such as the example shown below: 
 

 
 

Figure 3-44.  Dependency Viewer 

 
The service categories are color-coded to represent whether they are impacted or not, as 
mentioned previously. 
 
The PATH tool allows the user to generate a notional priorities list of Critical Infrastructure 
Assets and services to be restored.  The AWARE tool generates timelines and costs for the Asset 
restoration and recovery estimates.  The user can view the timelines for the Assets by selecting 
View from the drop-down menu and then Schedule Timelines. Next the user selects the tab for 
Critical Assets which will then display a timeline for each of the Assets in prioritized order.  Any 
milestones set for the Critical Assets will be displayed on this graphic as well.  There are also 
tabs to view the Remediation Units timelines and a Combined Remediation Unit and Critical 
Asset timeline.   
 
The user can manually change the priorities of the Asset and Remediation Unit sequencing.  The 
user should select the View drop-down menu and the Schedule Priorities option.  This produces a 
pop-up window showing a combined listing of Assets at the top and Remediation Units at the 
bottom of the list.  If the user wants to reposition the priorities they just select one of the Assets 
or Remediation units and use the buttons on the form to move it up or down in the list.  
Alternatively, the user can just click-and-hold the mouse and move the selection to a new 
position on the list.  It should be noted that when an Asset is on the list above the Remediation 
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Unit where it is physically located the restoration activities will be performed on the Asset prior 
to the overall cleanup of the Remediation Unit.  When it is time for the Remediation Unit to be 
dealt with in the overall timeline, the Asset is factored out of the mix.  The reverse is also true.  If 
the user decides to elevate the priority of a Remediation Unit above any of the Assets in its 
geographic area, the Assets will be restored as part of the overall Remediation Unit effort and 
when it is time for the Asset to be considered it is neglected because it was already accounted 
for.  This may be desirable when a significant number of Assets exist in a geographic area that 
would be better served by just cleaning up the whole of the Remediation Unit at once.  Note that 
by changing Asset priorities in this part of the code, information does not update in the PATH 
module. 
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